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1. Introduction to Outpost
• What is Packet Radio?
• Overview
• A Closer Look

2. Getting Started
• Finding Outpost
• Hardware configuration
• Confirm your BBS
• Outpost configuration
• First Message

3. Summary
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What is Packet Radio?
… in a nutshell

• Amateur Packet Radio is one of many digital modes that Hams can use to 
build wireless computer networks

• Amateur Packet is built on the AX.25 protocol, a mature extension of the 
industry standard X.25.  This protocol comes with transparency, error 
correction, and automatic control

• Data transfer speeds range from 1200 baud up to 19.6K Baud (frequency 
dependent; higher speeds = wider bandwidth)

• AX.25 Packet establishes a “private connection” between two stations while 
sharing a frequency with other stations

• Packet can use Bulletin Board Systems (BBSs) for dropping off and retrieve 
messages between users
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What is Packet Radio?
What are the components?

TNC AntennaRadio

• Computer: runs a “terminal emulation” program

• TNC: Terminal Node Controller; similar to a telephone
modem; the interface between your radio and
your computer; Sound-card TNCs also exist.

• Radio: …and antenna; transmits the digital data sent to
the TNC to another packet station
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What is Packet Radio?
What can we connect to?

BBS station

Keyboard to
Keyboard

Personal BBS
and Mailbox

TNC AntennaRadio

May forward to 
other BBS stations 
or the internet

Definition: BBS – Bulletin Board System, 
a station that is configured as a “message 
drop” for connecting stations.  May be 
stand-alone or networked to other BBSs or 
the Internet.  Several software-based BBS 
applications are out there.

Definition: PBBS – Personal Bulletin 
Board System, a minimal station that is 
configured as a “message drop”.  Usually 
implemented in hardware.

Home, EOC Packet Station
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Overview
Outpost Packet Message Manager

What is Outpost?
• A Windows-based packet messaging client
• Supports ARES, RACES, and other amateur radio emergency response

teams and their need to pass digital traffic
• Helps automate the packet message handling environment
• Manages all message-handling between you and your BBS
• Lets you read, delete, create, reply to, or forward messages back to the BBS

Main purpose…
• Enables ARES / RACES teams to support the response efforts and 

requirements of our local served agencies by pass digital traffic
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Overview
Outpost Packet Message Manager

Op Area/SCC

CUPCBL LGT MTV SJC

CA State OES

FEMA

…
Local Level
towns and
cities

Counties…

Coastal Region

Op Area/SF Op Area/Alameda…

Inland Region Southern Region

The California environment… and
our served agencies

State OES…

Three state regions…
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Overview
Outpost Packet Message Manager

Why use Outpost?
• Leverages the existing packet hardware, network, & BBS infrastructure

• Compatible with many existing BBSs and TNC PBBSs
• Uses your existing TNC and packet radio equipment
• Only a packet client (end-user) change is required

• Hides the complexity of the packet operating environment
• Similar look and feel to contemporary email programs
• Shorter learning curve for packet operations
• Allows users to… “focus on the message, not the medium”

• Implements most local emergency management policies for digital 
communications

• Still under active development based on user requests and on-going 
alignment with the Outpost mission
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Overview
Outpost Packet Message Manager

General Outpost Features
• Managing Messages

• Supports the three primary message types:  Private, NTS, and Bulletins
• Text Formatting in a free-form message window
• NTS Message Maker with automated ARL message support
• On-line report builder using report templates
• Supports Urgent message, Delivery and Read Receipts

• Send/Receive Sessions 
• Supports Serial, AGWPE, and Telnet interfacing with over 20 of PBBS and BBSs
• Automatically controls the sequence for initializing the selected interface, 

connecting to, and sending messages to and retrieving messages from the BBS
• Configurations and Setups

• BBS, TNC, and Interfaces – manages a list of BBSs & Interfaces
• Message Retrieval – choose the message types to be retrieved
• Send/Receive automation – 3 ways for automatically initiating S/R sessions
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A closer look
Outpost Packet Message Manager

Managing Messages
• Familiar email-app look and 

feel
• Separate folders for message 

storage
• Clear message identification 

(unread=BOLD, urgent=Red)
• Follows a typical message 

workflow
• Manages BBS and interfaces
• Various settings to control how 

Outpost behaves
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A closer look
Outpost Packet Message Manager

Creating Messages
• Familiar email-app look & feel

• Supports Private, Bulletin, 
and NTS message types

• Freeform message formatting 
before sending

• Set messages to Urgent
• Delivery and read receipts
• Different ways for originating 

messages
• NTS Message Maker
• Online Reports



12 Getting Started with Outpost 

A closer look
Outpost Packet Message Manager

Viewing Messages 
• Supports viewing, printing, 

deleting or saving a message 
to a local file

• Reply and Forward message 
formatting
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A closer look
Outpost Packet Message Manager

Application setups
• TNCs: create, update, or delete

• Configure Serial Comm Ports that 
are associated with each TNC

• BBSs: create, update, or delete
• Change the Station Identifier 

(the call sign assigned to the TNC)
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A closer look
Outpost Packet Message Manager

Types of controls
• Controls the flow of each Send/Receive 

Session 
• Sets how messages are created and handled
• Set various data fields to automatically 

populate on-line reports, messages, other 
areas

• Set up default Directory Names
• Various Log Settings
• Controls to re-size message listing column 

widths
• Separate Packet programs for Serial, 

AGWPE, and Telnet where the user can 
manually interact with the TNC or BBS
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A closer look
Outpost Packet Message Manager

Aligning features to needs

Mission: How do we support our served agencies in their 
efforts to minimize loss of life and property, and speed 
the recovery?

Environment: Environments are different… how do we adapt our 
tools to our environment?

Policy: In a community of packet users, what policies do we 
adopt to ensure order, consistency, and efficiency in 
what we do?
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A closer look
Outpost Packet Message Manager

Helps implement packet operating policies…

1. All stations will identify with a tactical call sign

2. All messages are sent as private messages

3. All messages are uniquely identified

4. All messages are as short as possible

5. All stations will poll the BBS periodically for traffic

6. All stations will poll for specific message types

7. All message traffic becomes part of the official event 
documentation package
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Getting Started
Outpost Packet Message Manager

1. Finding Outpost

2. Hardware configuration

3. Confirm your PPB or PBBS

4. Outpost configuration 

5. First message
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1. Finding Outpost
Outpost Packet Message Manager

1. Where to find it… 
http://www.outpostpm.org/

2. Download the latest version 
into a temp directory

3. Run the install program

4. Choose the install type
• Update for existing users
• First time installation for new users
• Custom installation

5. Outpost is installed in
c:\Program Files\Outpost

http://www.outpostpm.org/
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2. Hardware configuration
Outpost Packet Message Manager

What you should have
1. PC – Windows’98 or greater

2. TNC – 1200 baud is the most common speed TNC

• Several “TAPR2” TNCs mfgrs are supported: AEA/TimeWave, 
Kantronics, MFJ, Kenwood built-ins (see http://www.outpostpm.org/support.html)

• Or… AGWPE Software: sound-card packet, KISS-only TNCs

What you need to know
1. Interface Type: [ TNC serial | AGWPE | telnet ]

2. PC’s Serial Comm Port number: ____

3. Serial Baud, data bits, parity, stop bits: (usually 9600,8,none,1)

4. When in doubt, consult your TNC manual

TNC AntennaRadio

http://www.outpostpm.org/support.html
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2. Hardware configuration
Outpost Packet Message Manager

1. Manually configure and 
conform your TNC connection
• Use the Ipserial.exe program (in the 

c:\Program files\Outpost directory)
• File > Comm Port Settings
• Enter your TNC settings… OK
• Power up your TNC
• Press Connect… confirm the TNC is 

present!

2. Add Comm Port Settings 
to Outpost
• Tools > “Add Comm Port 

settings to Outpost”… give 
the TNC a name, Press OK

• Congratulations!  Your 
TNC is configured 

• If you did not get this far,
STOP!  Do not Proceed!



21 Getting Started with Outpost 

3. Confirm your BBS/PBBS
Outpost Packet Message Manager

1. Type of your BBS/PBBS

2. What is the connect name? __________ (ie: K6FB-2)

3. What is the BBS frequency? __________ (ie: 145.050)

4. Set the radio frequency, and manually 
connect to the BBS/PBBS

5. For Software BBSs…
• Register if prompted
• Set yourself up as Expert
• Turn off Paging
• See the Outpost website/BBS 

Support pages for help

6. You are ready for Outpost!
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4. Outpost Configuration
Outpost Packet Message Manager

1. Run Outpost
• from the Icon on the desktop, or
• Start > Programs > Outpost > Outpost PMM

2. The Station Identification form is 
presented
• Enter your call sign and name… press OK

• Turn off this prompting at Outpost startup 
from Tools > General Settings tab
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4. Outpost Configuration
Outpost Packet Message Manager

3. Confirm the TNC configuration…

4. From Outpost: Setups > TNC
• TNC Prompts and TNC command default 

settings should be valid.

• TNC Comm Port reflects your setup from 
Ipserial.exe.

• Press OK
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4. Outpost Configuration
Outpost Packet Message Manager

3. Define the BBS configuration…

4. From Outpost: Setups > BBS
• Press New

• Enter the BBS Connect Name 
(ie: K6FB-2)

• Enter a description of the BBS

• BBS Prompts and BBS Commands 
default settings should be valid.

• BBS Path defaults to Direct 
(change for digipeating or through 
KA-Nodes/NETROM)

• Press OK
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4. Outpost Configuration
Outpost Packet Message Manager

5. Note the Status Bar and the current Outpost settings
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4. Outpost Configuration
Outpost Packet Message Manager

6. Tools > Send/Receive Settings
• Selects different ways to automate the 

message send/retrieve sessions
• Select which message types are to be 

retrieved
• Once a message is received, select what to 

do with it
• Additional controls (Other tab)

manage printing received and 
sent messages
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4. Outpost Configuration
Outpost Packet Message Manager

7. Message Settings
• Define default settings for new messages, 

includes
• Default destinations
• Auto message numbering
• Message Signature

• Handling replies and forwards 
• Set up defaults for requesting message 

receipts
• Setting for permanently deleting messages 
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4. Outpost Configuration
Outpost Packet Message Manager

Field On-Line
Reports

NTS
Message 

Maker

Message
Subject 

Line

Next Message Number X X X
Organization X
City X X
County X
State/Prov X X
Tactical Location X
Tactical ID X X
Tactical TX Text X
Text Variable #2, 3 X

8. Report Settings
• Message number automatically increments 

and populates…
• Subject Line
• NTS Messages
• On-line reports

• Standard report variables automatically 
replace <tags> in On-line Reports 
(described later)

• Note where tags are used…
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5. First Message
Outpost Packet Message Manager

9. Create your first message
• From Outpost main form, press New
• Note what is filled in:

• BBS
• From
• Subject Msg ID
• Signature

• Address it to yourself for a 
round-trip message

• Fill in the balance of the 
subject line

• Fill in the body of the message
• Press “Send” when done
• Message is placed in the 

Out Tray
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Exit the BBS,
Shut down the Interface

Initialize the Interface

Connect to the BBS

Send all messages
from Out Tray

If Private is set
• Retrieve List, Read, and 

Delete each message

If NTS is set,
• Retrieve List and Read 

each message

If Bulletins is set,
• Retrieve List, if don’t 

have it, read each 
message

Send any message
delivery, read receipts

Process Bull, NTS deletes

5. First Message
Outpost Packet Message Manager

10. Send your first message
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Exit the BBS,
Shut down the Interface

Initialize the Interface

Connect to the BBS

Send all messages
from Out Tray

If Private is set
• Retrieve List, Read, and 

Delete each message

If NTS is set,
• Retrieve List and Read 

each message

If Bulletins is set,
• Retrieve List, if don’t 

have it, read each 
message

Send any message
delivery, read receipts

Process Bull, NTS deletes

5. First Message
Outpost Packet Message Manager

• Influenced by…
• Send/Receive Settings

• Send Messages
• Only sent from the Out Tray to this BBS
• Messages must be “Sent” not “Saved”
• Moved to Sent Folder when sent

• Retrieve Messages
• Depends on the Retrieve settings; if none are selected, 

none are retrieved
• Depends on the “Keep on BBS” setting
• Bulletins are never deleted
• New messages are stored in the In Tray

• Send Receipts
• Any pending Delivery and Read Receipts are sent back to 

the requester
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For more information
Outpost Packet Message Manager
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For more information
Outpost Packet Message Manager

Visit the Outpost website…
http://www.outpostpm.org

And supporting links…
• Users Guide… http://www.outpostpm.org/#documentation
• HOW-TOs… http://www.outpostpm.org/howto.html
• Support Info… http://www.outpostpm.org/support.html
• Users group… http://groups.yahoo.com/group/outpostpacket/

Send inquiries to…
Jim Oberhofer, kn6pe@arrl.net

http://www.outpostpm.org/#documentation
http://www.outpostpm.org/
http://www.outpostpm.org/howto.html
http://www.outpostpm.org/support.html
http://groups.yahoo.com/group/outpostpacket/
mailto:kn6pe@arrl.net
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Thank you!
Any Questions?
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